Teamwork in ATLAS.ti 8
Windows + Mac
(Mixed Teams)
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Procedure</td>
<td>4</td>
</tr>
<tr>
<td>Overview Of Main Steps</td>
<td>4</td>
</tr>
<tr>
<td><strong>1. Setting Up The Team Project – Tasks of The Project Administration (Windows)</strong></td>
<td>5</td>
</tr>
<tr>
<td>Creating A Project</td>
<td>5</td>
</tr>
<tr>
<td>Adding Documents</td>
<td>5</td>
</tr>
<tr>
<td>Adding Document Groups</td>
<td>6</td>
</tr>
<tr>
<td>Adding Codes And Code Groups</td>
<td>6</td>
</tr>
<tr>
<td>Saving The Project</td>
<td>7</td>
</tr>
<tr>
<td>Exporting The Project For Distribution</td>
<td>8</td>
</tr>
<tr>
<td><strong>1. Setting Up The Team Project – Tasks of The Project Administration (Mac)</strong></td>
<td>9</td>
</tr>
<tr>
<td>Creating A Project</td>
<td>9</td>
</tr>
<tr>
<td>Adding Documents</td>
<td>9</td>
</tr>
<tr>
<td>Adding Document Groups</td>
<td>10</td>
</tr>
<tr>
<td>Adding Codes And Code Groups</td>
<td>10</td>
</tr>
<tr>
<td>Saving The Project</td>
<td>12</td>
</tr>
<tr>
<td>Exporting The Project For Distribution</td>
<td>12</td>
</tr>
<tr>
<td><strong>2. Working On the Project (Team Members, Windows)</strong></td>
<td>13</td>
</tr>
<tr>
<td>Importing The Master Project And Renaming It</td>
<td>13</td>
</tr>
<tr>
<td>Exporting Sub Projects For The Project Administrator</td>
<td>14</td>
</tr>
<tr>
<td><strong>2. Working On the Project (Team Members, Mac)</strong></td>
<td>14</td>
</tr>
<tr>
<td>Importing The Master Project And Renaming It</td>
<td>14</td>
</tr>
<tr>
<td>Exporting Sub Projects For The Project Administrator</td>
<td>14</td>
</tr>
<tr>
<td><strong>3. Merging Projects – A task for The Project Administrator</strong></td>
<td>14</td>
</tr>
<tr>
<td>Terminology and Procedure</td>
<td>15</td>
</tr>
<tr>
<td>How to Merge (Windows)</td>
<td>17</td>
</tr>
<tr>
<td>How to Merge (Mac)</td>
<td>18</td>
</tr>
<tr>
<td>Distributing The New Master File To Team Members (Win &amp; Mac)</td>
<td>20</td>
</tr>
<tr>
<td><strong>4. Continuing Workflow (Team Members, Win &amp; Mac)</strong></td>
<td>20</td>
</tr>
<tr>
<td>Importing The New Master File &amp; Renaming</td>
<td>20</td>
</tr>
<tr>
<td><strong>Appendix</strong></td>
<td>21</td>
</tr>
<tr>
<td>Useful Resources</td>
<td>21</td>
</tr>
<tr>
<td>Where are ATLAS.ti Windows Project Data Stored</td>
<td>21</td>
</tr>
<tr>
<td>Changing the Default Location for ATLAS.ti Project Data (Windows)</td>
<td>21</td>
</tr>
<tr>
<td>Creating User Accounts (Windows)</td>
<td>23</td>
</tr>
<tr>
<td>Password Protection (Windows)</td>
<td>24</td>
</tr>
<tr>
<td>Where Are ATLAS.ti Mac Project Data Stored?</td>
<td>24</td>
</tr>
<tr>
<td>Changing the Default Location for ATLAS.ti Project Data (Mac)</td>
<td>24</td>
</tr>
<tr>
<td>Creating User Accounts (Mac)</td>
<td>27</td>
</tr>
<tr>
<td>Password Protection (Mac)</td>
<td>27</td>
</tr>
</tbody>
</table>
General Procedure

In this document we describe how you set up a team project when working in a mixed ATLAS.ti 8 Windows and ATLAS.ti Mac team. Due to the differences in operating systems, the instructions for Windows and Mac differ. You find different boxes with instructions for Mac and Windows users.

If all team members use the Mac version, or the Windows version, please check our website for the instructions that fit your situation.

Each team member needs to work on his or her copy of the project locally in the designated ATLAS.ti folder. In the future, it will also be possible to select a user-defined location for ATLAS.ti project data.

The kind of team work supported is shared coding and analyzing. This means if you have a lot of data you can spread the coding work across different team members. Each team member codes parts of the data and the work of all coders is put together via merging the various sub projects.

If you are interested in running an intercoder agreement analysis, see the full manual for a detailed description.

Overview Of Main Steps

1. The project administrator sets up the projects. Let’s call the project administrator “Mary,” and the project “Master Project”.
2. Mary adds documents to the project and possibly a list of codes.
3. She saves the project and exports it. This means creating a project bundle file (see Figure 1).
4. All team members import the project bundle file and begin their work.
5. To combine the work of all team members, each team member creates a project bundle file and sends it to Mary.
6. Mary merges all sub projects and creates a new Master file.
7. Mary exports the new Master file and distributes it to all team members (see Figure 2).
8. The team members continue their work.
9. This cycle continues. If new documents need to be added to the project, this needs to be done by Mary. A good time for this is after merging and before creating the new Master file.

Figure 1: Steps 1 and 2: Creating and distributing the Master project
The instructions below are organized by the various tasks involved when working as a team. There are operating instructions for team members and for the project administrator, divided by Mac and Windows users.

### 1. Setting Up The Team Project – Tasks of The Project Administration (Windows)

#### Creating A Project

If you open ATLAS.ti, select **CREATE NEW PROJECT** from the start window. If a project is already open, select **FILE** and then **PROJECT / NEW**. Next, click on the option: **CREATE NEW PROJECT**. Enter a project name like “Master_(project name)_date” and click **CREATE**.

#### Adding Documents

The standard procedure is that documents are imported. This means a copy of the document is created, converted into an ATLAS.ti compatible format and stored in an internal library.

For audio and video files you have the option to link them to your project. This avoids file duplication and saves hard disk space, as especially video files can be quite sizable. When you link a file to a project, it is not copied and imported into the project. It remains at its source location and ATLAS.ti opens it from there when needed.

This means that the file should remain at this location. You should not rename or move it to a different folder. If this happens, the file can no longer be displayed in the project and you need to redirect ATLAS.ti to its new location.

To add documents, click on the **ADD DOCUMENTS** button in the **HOME** tab, or click on the dialog box launcher (drop-down arrow).
If you click on “Add Documents” you can select individual files. If you want to add entire folders, click on the dialog box launcher. All documents that you add to a project are copied and become internal ATLAS.ti files.

If you want to analyze larger-size audio or video files, use the **ADD LINKED VIDEO/AUDIO** option. If a linked file can no longer be loaded because the link is broken, a message will pop up asking you to redirect ATLAS.ti to the new location of the file.

Linked files are currently automatically added to an exported project. This could mean that your exported projects are quite sizable. With future updates you will have the option to exclude them and to transfer them separately. An option then is to store them at a central location where all team members can access them.

**Adding Document Groups**

You may also want to consider to group documents at this stage. The groups might reflect sample characteristics like demographic variables, locations, or time of data collection. They can also be used to support team work. In the latter case, you may want to create a document group for each team member and assign the documents they are supposed to code.

To add document groups, open the Document Manager with a click on the **DOCUMENTS** button, or via the main document menu.

Select the items you want to group by holding down the Shift or Cmd-key. Drag and drop the selected items into the side panel to the left (see Figure 18).

**Adding Codes And Code Groups**

If a common set of codes and code groups is to be used, they also must be added to the project at this stage. If each team member were to add the codes / code groups individually to each sub project, all codes and groups would be multiplied during the merge process (see “Merge Strategy” on page 15).

**Importing A List Of Codes, Code Definitions And Groups**

You can prepare a list of codes including code descriptions, code groups and colors in Excel and import the Excel file. This is how you need to prepare the Excel file:

- You can enter headings like **Code**, **Code Definition**, **Code Group 1**, **Code Group 2**, but you do not have to. If you do not enter headings, the columns are interpreted in the following order:
  - 1. column: code name
  - 2. column: code description (comment)
  - 3. column: code group
  - 4. column: code group
  - all subsequent columns: further code groups
1. SETTING UP THE TEAM PROJECT – TASKS OF THE PROJECT ADMINISTRATION (WINDOWS)

If you color the code names, this color is used in ATLAS.ti as code color.

- To import the Excel file, select the **Import / Export** tab and next the Import Codes button (the one with the down arrow).

**Adding Codes And Code Definitions Manually**

- To add codes, click on the **New Entities** button in the **Home** tab and select **New Codes** from the drop-down menu.
- To add code definitions or coding rules, open the Code Manager with a click on the Codes button in the Home tab.
- Select a code and write a description or coding rule in the comment field below.

**Creating Code Groups Manually**

- To add groups, open the Code Manager with a click on the **Codes** button in the **Home** tab.
- Select the items you want to group by holding down the Shift or Ctrl-key. Drag and drop the selected items into the side panel to the left.
- Enter a name for the group.
Saving The Project

To save a project, click on the Save icon in the Quick Access tool bar (see left), or select FILE / SAVE. The project is saved as internal ATLAS.ti file in the application folder on your computer.

It is possible to change the default location where ATLAS.ti stores project data. For more information see “Changing the Default Location for ATLAS.ti Project Data (Windows)”.  

Exporting The Project For Distribution

To export the project for distribution to all team member, select FILE / EXPORT.

Click on the PROJECT BUNDLE button. This opens the Windows File Manager. Select a location for storing the project bundle. The default project bundle name consists of the project name plus the author and date in parentheses behind it. E.g. “Project X (Mary 2017-09-27)”. 

Distribute the project bundle file to all team members, e.g. via email, a folder on a server that everyone can access, or also via a cloud link or cloud folder. 

The project bundle file has the file extension “.atproj” and can be read by both ATLAS.ti 8.1 Windows and Mac.
1. Setting Up The Team Project – Tasks of The Project Administration (Mac)

Creating A Project

To create a new project, select Project / New from the main menu. Click on the option: Create New Project. Enter a project name like “Master_(project name)_date” and click Create.

Adding Documents

The standard procedure is that documents are imported. This means a copy of the document is created, converted into an ATLAS.ti compatible format and stored in an internal library.

For audio and video files you have the option to link them to your project. This avoids file duplication and saves hard disk space, as especially video files can be quite sizable. When you link a file to a project, it is not copied and imported into the project. It remains at its source location and ATLAS.ti opens it from there when needed.

This means that the file should remain at this location. You should not rename or move it to a different folder. If this happens, the file can no longer be displayed in the project and you need to redirect ATLAS.ti to its new location.

To import text, PDF or image documents to your project, select Document / Import Documents....

An alternative to using the main menu option to add documents is to click the + button on the top left hand side of your screen (see below).

You can also drag & drop documents or folders from the Finder into the Document Manager or the navigator for documents.
To link audio or video documents to your project, select **DOCUMENT / IMPORT LINKED MULTIMEDIA DOCUMENTS**. When you open the Document Manager, you will see the location of the file in the column “Origin” (see Figure 14).

**Redirecting a linked file that can no longer be loaded**

If a linked file was renamed or moved, you need to let ATLAS.ti know about the new file name or location: Open the Document Manager and right-click on the document. Select the option **USE DIFFERENT FILE** and select the renamed file, or point ATLAS.ti to the new location.

Linked files are currently automatically added to an exported project. With future updates you will have the option to exclude them and to transfer them separately.

Adding Document Groups

You may also want to consider to group documents at this stage. The groups might reflect sample characteristics like demographic variables, locations, or time of data collection. They can also be used to support team work. In the latter case, you may want to create a document group for each team member and assign the documents they are supposed to code.

To add document groups, open the Document Manager with a click on the **DOCUMENTS** button, or via the main document menu.

Select the items you want to group by holding down the Shift or Cmd-key. Drag and drop the selected items into the side panel to the left (see Figure 20).

Adding Codes And Code Groups

If a common set of codes and code groups is to be used, they also must be added to the project at this stage. If each team member were to add the codes / code groups individually to each sub project, all codes and groups would be multiplied during the merge process (see “Merge Strategy” on page 15).

**Importing A List Of Codes, code Definitions And Groups**

You can prepare a list of codes including code descriptions, code groups and colors in Excel and import the Excel file. This is how you need to prepare the Excel file:
1. SETTING UP THE TEAM PROJECT – TASKS OF THE PROJECT ADMINISTRATION (MAC)

You can enter headings like Code, Code Definition, Code Group 1, Code Group 2, but you do not have to. If you do not enter headings, the columns are interpreted in the following order:

- 1. column: code name
- 2. column: code description (comment)
- 3. column: code group
- 4. column: code group
- all subsequent columns: further code groups

If you color the code names, this color is used in ATLAS.ti as code color.

To import the Excel file, select the **CODE / IMPORT CODE LIST**.

The finder offers the following three options at the bottom of the window:

- **Ignore header (first row) during import**
- **Update existing codes**
- **Keep existing codes**

If you have added header information like code, code definition, group, etc., activate the first option **Ignore header (first row) during import**.

Select **Update existing codes**, if the project already contains codes that have the same name as already existing codes.

Select **Keep existing codes**, if you want to add all codes from the Excel file to the already existing list of codes.

**Adding Codes & Code Definitions Manually**

- To add codes, click on the **+** button at the top left of your screen and select **New Code(s)** from the drop-down menu.

- To add code definitions or coding rules, open the Code Manager with a click on the Codes button, or select **CODE / SHOW CODE MANAGER** from the main menu (short-cut: cmd+3).

- Select a code and write a description or coding rule in the comment field to the right.
1. Setting Up the Team Project - Tasks of the Project Administration (Mac)

Creating Code Groups Manually

To add code groups, open the Code Manager with a click on the Codes button, or via the main Code menu.

Select the items you want to group by holding down the Shift or Cmd-key. Drag and drop the selected items into the side panel to the left.

Enter a name for the group.

Saving The Project

By default, all project data are stored in the application folder for ATLAS.ti. If you want to add this location to your routine backup, e.g. using Time Machine, this is the location:

~/Library/Application Support/ATLAS.ti.

This default location can be changed. See “Changing the Default Location for ATLAS.ti Project Data (Mac),”

Exporting The Project For Distribution

Figure 19: Adding code definitions / coding rules in ATLAS.ti Mac

Figure 20: Creating a group in a manager

Figure 21: Creating and distributing the Master project
1. Setting Up the Team Project – Tasks of the Project Administration (Mac)

- Select **Project / Export Project**. Select a location for storing the project bundle.
- Distribute the project bundle file to all team members, e.g. via email, a folder on a server that everyone can access, or also via a cloud link or cloud folder.

Project bundle files can be shared via a cloud like Dropbox, OneDrive, GoogleDrive, etc. Another option is to upload the project bundle file to a server and send a link to all team members so that they can download the file.

The Mac project bundle file has the file extension “.atlproj” and can also be read by ATLAS.ti 8.1 Windows.

- The default name of the bundle is the project name. You can rename the bundle file at this stage. However, please note – renaming the bundle does not automatically change the name of your project. Think of the project bundle file like a box that contains your project. Putting a different label on the outside of the box does not change anything that is inside.

2. Working On the Project (Team Members, Windows)

The first task of the team members is to import the project and to rename it. Renaming is necessary for the later merging process. If all team members are done with the task assigned to them, they return the project to the project administrator for merging. If the project administrator were to receive two or more projects that all have the same name, it would be difficult to determine which projects to merge.

It is recommend that all team members save a copy of the project bundle file their receive on their computer, or their personal space on a server.

### Importing The Master Project And Renaming It

- Open ATLAS.ti and select the **Import Project Bundle** button. If another project is currently open, select File / New and then the import Project Bundle option.
- During the process of importing the project, the name of the project can be changed:

  ![Import Project Bundle](image)

  **Figure 22**: Renaming a project file during the process of importing a project bundle

- Rename the project by adding your name or initials to the project name. This is important for the project administrator later when he or she merges the projects of all team members (see Figure 22).
- Click **Import**.
2. Working On The Project (Team Members, Windows)

RENAMEING PROJECTS ON THE OPENING SCREEN

If you want to rename a project after it is imported, you can either do it on the opening screen when starting ATLAS.ti. If the project is already open, you need to close it to return to the opening screen.

On the opening screen, right click on the project that you want to rename and select RENAME PROJECT.

Exporting Sub Projects For The Project Administrator

After an agreed period of time where everyone has done some work on the project, team members create their own project bundle file and send it to the project administrator.

To export the project, select FILE / EXPORT. The name of the exported bundle file will include the name of the currently logged in user and the date, e.g. Project X, coder 2 (Tom 2017-09-30).

2. Working On The Project (Team Members, Mac)

The first task of the team members is to import the project and to rename it. Renaming is necessary for the later merging process. If all team members are done with the task assigned to them, they return the project to the project administrator for merging. If the project administrator were to receive two or more projects that all have the same name, it would be difficult to determine which projects to merge.

It is recommend that all team members save a copy of the project bundle file they receive on their computer, or their personal space on a server.

IMPORTING THE MASTER PROJECT AND RENAMING IT

Open the project bundle file by double-clicking, or open ATLAS.ti Mac first and select PROJECT / IMPORT PROJECT from the main menu.

To rename the imported project:

Select PROJECT / RENAME. Add for example your name or initials to the Master project file name. Example: “Master (project name).date_SF”

EXPORTING SUB PROJECTS FOR THE PROJECT ADMINISTRATOR

After an agreed period of time where everyone has done some work on the project, team members create their own project bundle file and send it to the project administrator.

To export the project, select PROJECT / EXPORT.
3. Merging Projects – A Task for The Project Administrator

The Merge Tool reunites projects that were originally divided for analytical or economical reasons. It brings together the contributions of different members of a research team. In the following a few general principles about merging are explained:

**Terminology and Procedure**

**Master And Imported Projects**

The Master project is the project into which another project, called the "Import project" is merged. The Master project has to be loaded first before invoking the Merge Project option.

**Merge Strategy**

The default option is to unify all objects that are identical and to add all objects that do not yet exist in the Master project.

**IDENTICAL ENTITIES EXPLAINED**

When an entity is created in ATLAS.ti—regardless if it is a document, a code, a quotation, a memo, a network, a group or a comment—this entity receives a unique ID, comparable to a fingerprint. When merging projects, ATLAS.ti compares the IDs of the various entities. If they have the same ID (fingerprint), they are unified. If the fingerprint is different, they are added. Thus, the name of an entity is not the decisive factor. If Tom has created a code with the name "sunshine" and Anne also has created a code with this name in her project, these two codes are not identical as they have different IDs. If you merge Tom’s and Anne’s project, the merged project will contain two codes: sunshine and sunshine(2). If the meaning of both codes is the same and you want to keep one sunshine code only, you can merge the two codes manually (see Windows: "Housekeeping", Mac: "Housekeeping").

Identical entities are unified, all others are added.

**EXAMPLES**

**Groups are additive**: Group B with documents {1, 2, 3} in the Master project merged with Group B’ with documents {3, 4} in the Import project will result in Group B= {1, 2, 3, 4} in the merged project.
3. MERGING PROJECTS – A TASK FOR THE PROJECT ADMINISTRATOR

Entities with and without comments: If there is a code C in the Master project that has no comment, and a code C in the Import project that has a comment, the merged procedure will add this comment to the merged project.

In the case of an unsolvable conflict - code C in the Master project has a comment, and code C in the Import project also has a comment - the user can define which of the two conflicting entities will win. If the comment of the Master project should be kept, you need to select the option “Keep”. If the comment of the Import project should be kept, you need to select the option “Override” as shown in Figure 28.

The decision which changes to keep can currently be taken only for all entities. In the future, you will be able to decide for each entity how the conflict should be resolved.
3. Merging Projects – A Task for the Project Administrator

How Deleted Entities are Handled: It is not possible to "subtract" entities. If one team member has deleted a code and some of these codings still exist in another project to be merged, the merged project will contain those codes or codings again.

If you want to clean up a project, this is best done in a “fresh” Master project after merging and before distributing the new Master file to all team members.

How to Merge (Windows)

Before you merge, the recommendation is that you import all project bundle files first and take a look at the projects. If a conflict arises during the process of merging, you need to decide whether to keep all changes in the Master project or whether to override them. If you do not know what is contained in the projects to be imported, you cannot make an informed decision. Principally, it is possible to merge project bundle files without importing them prior to merging.

To begin the merge process, open the Master project.

Select **FILE / MERGE**.

You have the option to select either a project or a project bundle file. If you have previously imported the bundle files of all team members, select MERGE PROJECT; otherwise MERGE PROJECT BUNDLE.

Select a project from the list offered by ATLAS.ti, or load a project bundle file.

If you have a long list of projects, just enter the first few letters of the project name into the Search field.

In both cases, you have the option to create a snapshot of the current project before merging. There may be times, when you want or need to go back to an older version of your project. The default name for snapshot project is: project name (Snapshot-date-time).

After selecting a project or project bundle, click on the MERGE button.

![Diagram showing the process of merging projects](image)

Figure 29: Example 4: Merging always adds entities, never subtracts

Figure 30: Select either a project file or a project bundle to merge
ATLAS.ti checks the two projects for identical and different items. All identical items will be merged, all different items will be added. See "Merge Strategy" on page 15 for further detail. After this process is completed, you see a Pre-Merge Summary:

![Pre-Merge Summary](image)

**Figure 31: Check the pre-merge summary for conflicts**

- If there are no conflicts, you can proceed with merging the two projects by clicking **Merge**.
- If there are conflicts between the Master project and the project that you import, you can solve the conflict in two ways (see “Examples” on page 15).
  - **Keep** means, the Master project “wins” and the changes made in the project that you import will be ignored.
  - **Override** means, that all changes made in the project to be imported “win” and the entries in the Master project are overridden.

  After merging, check the final merge report and the merged project for plausibility. If you are satisfied with the results, save the project. If not, you can always select **Undo**.

- If applicable, continue with merging the next sub project or project bundle file.

**Housekeeping**

After merging all sub project, the project administrator may need to do some house keeping work like cleaning up the code list, adding or modifying code groups, adding a memo with information for the team, or adding new documents and document groups.

**Merging Duplicate Codes**

You need to do some housekeeping, if you find duplicate codes in the merged project. This can for instance happen if team members independently have added codes that have the same name. As these codes have been created in different projects, they have different IDs and therefore they are added and not merged. The naming convention for duplicate codes is as follows:

- code A
- code A (2)

Duplicate codes can be merged as follows:

**Video tutorial**: ATLAS.ti 8 Win - Mac compatibility /Merging projects across platforms

**How to Merge (Mac)**

Open ATLAS.ti without opening the Master project. We first want to duplicate the Master project and this can only be done when it is closed. The previous version can be kept as backup. There may be times, when you want or need to go back to an older version of your project.
To duplicate the Master project, select **PROJECT / OPEN**, right click the Master project file and select the option **DUPLICATE** ...

You will be asked to enter a new name. We recommend the following structure: Master project name, date of merging and iteration of merging. For example: **Master_Neighborhood study_2017_03_18 (first merge).**

From the main menu select **PROJECT / MERGE WITH PROJECT**.

Select the project to be imported, i.e. a project bundle file from one of the team members.

A summary report opens. If there are conflicts, you can decide which project should "win.:

Select the option "**keep local changes**" if you do not want to change the entries in the Master project that conflict with entries in the project that you import.

Select the option "**Override all local changes**," if you indeed want the Master project to be changed and want to import all modifications made in the project that you import.

The summary report shown in Figure 32 does not contain conflicts. The project administrator "Susanne" has set up the project, adding documents and codes, and "Tom" has coded three data segments. If there are no conflicts, it does not matter which of the two options are selected.

![Figure 32: Merge summary report without conflicts](image)

The summary report in Figure 33 indicates that a code was renamed, a new code was added, and a document group was modified. In order to make a decision whether to keep these changes overriding the Master file, or whether to discard them (by keeping all local changes), the project administrator is best advised to first check the project to be imported. The Merge process can be canceled as this stage, if you decide that it is best to double-check the import project.

![Figure 33: Merge summary report with conflicts](image)

Select **OK** to initiate the merge process.

After merging you have the option to open and save a merge report that lists all actual changes to the project. Double-check the resulting project. You can always select **UNDO**, if you do not want to keep the merged project.

If merging was successful, save the new Master file (**PROJECT / SAVE**). If your team consists of several team members, continue with merging further sub projects.
Housekeeping
After merging all sub project, the project administrator may need to do some housekeeping work like cleaning up the code list, adding or modifying code groups, adding a memo with information for the team, or adding new documents and document groups.

Merging Duplicate Codes
If you find duplicate codes in the merged project, e.g., team members have added a code with the same name, you need to do some housekeeping. Duplicate codes can be merged as follows:

- Open the Code Manager. Drag the code you want to merge to a second code.
- Select MERGE.

If all team members have been coding different documents, merge conflicts are unlikely to occur. A conflict could, for instance, arise if someone has modified a document or code group. As project administrator, you have to decide whether to accept this change or not.

Video tutorials:
- ATLAS.ti Mac - Merging Projects
- ATLAS.ti 8 Win – Mac compatibility /Merging projects across platforms

Distributing The New Master File To Team Members (Win & Mac)
After all housekeeping work is done, save the Master project and export it for distribution to team members (Win: FILE / EXPORT, Mac: PROJECT / EXPORT).

As shown above, in the Windows version the name of the project administrator and the current date is added to the bundle file.

4. Continuing Workflow (Team Members, Win & Mac)

Importing The New Master File & Renaming
As before, team members import the new Master project and rename the Master file again adding their name or initials. See Windows instruction: “Importing The Master Project And Renaming It”, and see Mac instructions: Importing The Master Project And Renaming It.

Continue the cycle of project exchange and merging between project administrator and team members as needed.
Appendix

Useful Resources

Under the following link you find a playlist that contain useful video tutorials:

- This video tutorial shows the merge process in ATLAS.ti Mac, but it is very similar to how it works in ATLAS.ti 8 Windows: [ATLAS.ti Mac - Merging Projects]
- This video shows how to transfer projects between ATLAS.ti 8 Windows and ATLAS.ti Mac and shows the merge procedure in ATLAS.ti 8 Windows: [ATLAS.ti 8 Win – Mac compatibility /Merging projects across platforms]
- Under the following link you find a playlist that contain video tutorials about how to work with ATLAS.ti 8 Windows including how to create a project, how to add documents, how to add codes, how to create groups, etc.: [Quick Tour ATLAS.ti 8 Windows – English]
- Under the following link you find a playlist that contain video tutorials about how to work with ATLAS.ti Mac: [Quick Tour ATLAS.ti Mac – English]

Where are ATLAS.ti Windows Project Data Stored

ATLAS.ti projects and all documents that you add to a project are stored in the application folder on your computer. The Windows application folder is called: AppData and can be found under your user account’s home folder. Within the sub folder Roaming, you find folders from a number of different applications, also for ATLAS.ti. The AppData\Roaming folder is a hidden folder and can either be accessed by entering the full path name or by typing into the Windows 10 search field %appdata%. If the user name is “Mary”, the full path would be:

c:\Users\Mary\Appdata\Roaming\Scientific Software\ATLASti.8

This default location for storing ATLAS.ti data can be changed. See below.

The ATLAS.ti library is a system folder and not meant for user access. Files in this folder cannot be used outside ATLAS.ti.

Changing the Default Location for ATLAS.ti Project Data (Windows)

ATLAS.ti does not support cloud-based storage of library data. Cloud-based storage locations synchronize data across devices and therefore make unauthorized changes to the content of the library. This can potentially damage your projects. When selecting a library location, ATLAS.ti will check whether this location is a cloud-based storage and will not allow you to create a library at this location or move your existing library to this location. However, we can not guarantee that a cloud-based storage is always recognized. If you use a user-defined location for your library, it is your own responsibility to ensure that it is not on a cloud-based storage. ATLAS.ti GmbH rejects all responsibility for data loss resulting from such as setup.

As explained above, the default location for ATLAS.ti project files is on the C drive. As it is not possible for all users to work on the C drive, either because there are institutional restrictions, or the C drive is already full and there is not sufficient space, there is the possibility to create a user-defined location where all of your ATLAS.ti data is stored.

For all users familiar with ATLAS.ti 7, this is not the same as in version 7 where you could create project specific libraries that could be shared.

In ATLAS.ti 8, each user works within her or his own ATLAS.ti environment. What is new in version 8.1 is that you can define where this ATLAS.ti environment is located. This location can be within another folder on the C drive, any other drive on your computer, a server, or an external drive. It is not possible to use a cloud sharing service like Dropbox because this might jeopardize the integrity of your ATLAS.ti projects!

It is possible to work with multiple libraries. Potentially, you could create a new empty library every time you start a new project. This however requires careful data management on your part, as you need to keep track on your own where all of these different libraries are located.
We strongly recommend that you create project backups on a regular basis by exporting your projects (see “Exporting The Project For Distribution”).

If you start ATLAS.ti, select **Options** at the bottom left of your screen. If a project is already open, you need to close it first.

The last option under Application Preferences is to switch the library location.

A wizard opens that guides you through the process. The next choice you need to make is whether you want to open an existing library, move the library to a different location, or create a new empty library.

- **Open an existing library:** Chose this option if you work with multiple libraries and you want to gain access to an already existing library at a different location.
- **Move the library to a different location:** Chose this option if you want or need to move your current library to a different location, e.g. because you do no longer want to work on the C drive. It is possible to keep a copy of the library at the old location.
- **Create a new empty library:** This option allows you to create a new library at a location of your choice. If you already have projects, none of these will be moved over into the new library. To fill this library, you either create new projects from scratch, or you import project bundle files that you previously exported from other libraries.

After you made your choice, click **Next**.
If you selected to open an existing library, select the location for this library:

If you selected to move the library, select the location where you want this library to be. You can keep a copy of the actual state of the library at the current location. Just keep in mind that this copy is not updated if you continue your work using the library at the new location.

If you selected to create a new empty library, select where this new library shall be created. After confirming the new location, your opening screen will be empty and you can begin to fill it with new projects.

Creating User Accounts (Windows)

When you first opened ATLAS.ti, you were asked to add a user name. This name will be used to stamp all project entries.

If you want to check under which name you are working, select the Support tab and then User Manager or Switch User.

To create a new user account, select User Manager. After creating a new account, select Switch User to log in using a different user name.
Password Protection (Windows)

To set a password for your project, you need to load it first. Next select **File > Info**.

From there click on the **Set Password** button and follow the instruction on the screen.

![Password Protection](Image)

Figure 40: Setting a password

Please note that ATLAS.ti Scientific Software GmbH does not save your passwords. We cannot access, read or recover your password. If you cannot remember your password, you can no longer access your project.

Where Are ATLAS.ti Mac Project Data Stored?

ATLAS.ti saves all project data within its own ATLAS.ti environment. You can find all ATLAS.ti data under:

`~/Library/Application Support/ATLAS.ti`

If for some reason, you cannot store data at the default location, you can move the library to a different location or you can create one or more new libraries (see below).

The ATLAS.ti library is a system folder and not meant for user access. Files in this folder cannot be used outside ATLAS.ti.

Changing the Default Location for ATLAS.ti Project Data (Mac)

ATLAS.ti does not support cloud-based storage of library data. Cloud-based storage locations synchronize data across devices and therefore make unauthorized changes to the content of the library. This can potentially damage your projects. When selecting a library location, ATLAS.ti will check whether this location is a cloud-based storage and will not allow you to create a library at this location or move your existing library to this location. However, we cannot guarantee that a cloud-based storage is always recognized. If you use a user-defined location for your library, it is your own responsibility to ensure that it is not on a cloud-based storage. ATLAS.ti GmbH rejects all responsibility for data loss resulting from such a setup.

The default location for ATLAS.ti project files is on your Macintosh HD. As it is not possible for all users to store data at this location, either because there are institutional restrictions, or the drive is already full and there is not sufficient space, you can create a user-defined location where all of your ATLAS.ti data is stored.

Project libraries cannot be shared. Each user works within her or his own ATLAS.ti environment.

In ATLAS.ti 8, each user works within her or his own ATLAS.ti environment. You have the possibility to define where this ATLAS.ti environment is located. This location can be within another folder on the hard disk, any other drive on your computer, a server, or an external drive. It is not possible to use a cloud sharing service like Dropbox because this might jeopardize the integrity of your ATLAS.ti projects!
It is possible to work with multiple libraries. Potentially, you could create a new empty library every time you start a new project. This however requires careful data management on your part, as you need to keep track on your own where all of these different libraries are located.

We strongly recommend that you create project backups on a regular basis by exporting your projects (Project / Export).

Select ATLAS.ti / Switch Library.

The next choice you need to make is whether you want to open an existing library, move the library to a different location, or create a new empty library.

Open an existing library: Chose this option if you work with multiple libraries and you want to gain access to an already existing library at a different location.

Move the library to a different location: Chose this option if you want or need to move your current library to a different location, e.g. because you do no longer want to work on the C drive. It is possible to keep a copy of the library at the old location.

Create a new empty library: This option allows you to create a new library at a location of your choice. If you already have projects, none of these will be moved over into the new library. To fill this library, you either create new projects from scratch, or you import project bundle files that you previously exported from other libraries.

After you have made your choice, click Continue.

• If you selected to move the library, select the location where you want this library to be. You can keep a copy of the actual state of the library at the current location. Just keep in mind that this copy is not updated if you continue your work using the library at the new location.

Note that the ATLAS.ti 8 library contains all of your documents plus your project files. This is different from version 7, where only the project documents were stored in the library and the user saved the project file (HU) independently. In version 8, ATLAS.ti handles and manages all of your project related data in the library.
The option **open an existing library** is useful if you previously have created a library at a different location and want to access the projects contained in this library, or if you want to change back to the default library. The option “Default library location” is only active, if you currently use a user-defined library.

If you selected to **create a new empty library**, select where this new library is to be created. After confirming the new location, your opening screen will be empty and you can begin to fill it with new projects.

A note from the HelpDesk: We know that your project data is very valuable to you and that you do not want to lose it. Therefore, please select a sensible location for the ATLAS.ti library. For instance: Do not store it on the desktop.
probably have a folder within your document system for the project you are currently working on where you store all project related data. If you cannot or do not want to use the ATLAS.ti default location, we recommend that you create a sub folder for your ATLAS.ti related work within your project folder, and within this sub folder, a folder for your library. Make sure that your project folder is included in the automated back up routine of your computer.

Creating User Accounts (Mac)

When you first opened ATLAS.ti, you were asked to add a user name. This name will be used to stamp all project entries.  
1. If you want to check under which name you are working, select the main menu option **Tools / User Management / change User**.  
2. If you want to create a new user account, select **Show User Management**.

Password Protection (Mac)

Under the Project menu, you find an option to set a password for your project, or to delete it.  
1. To set a password, select **Project / Change Password**.

![Set project password dialogue](image)

As stated in the dialogue, a password cannot be recovered—also not by our technical team! (If it could, your project could also be hacked by someone else.) Thus, you must make sure not to forget the password. Store it in a secure place.

To remove a password from your project, select **Project / Delete Password**.